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1 Introduction to the User Guide
Welcome to the PLA 3.0 User Guide.

This guide describes the basic concepts of the PLA 3.0 user interface and provides details on
how to manage and work with documents and folders. It is intended for all users of PLA 3.0.
This guide is organized into the following parts:
• User interface of PLA 3.0: Get an overview of the user interface elements you use when
working with PLA 3.0, for example, the Navigator, the action bar, and the Dashboard.
• PLA 3.0 databases: Databases store all your data and also hold information such as user
accounts and audit trail information. When logging in to PLA 3.0, you connect to a specific
database, which sets your work environment for the session.
• Documents: PLA 3.0 stores all your data in electronic documents. Learn how to create and
organize documents and efficiently work with the Navigator.
• Templates: Use templates to provide initial values for your documents or apply protection
settings to document elements. In contrast to standard documents, templates should not
contain any data and can therefore not be calculated.
• Editors: PLA 3.0 provides several views on documents and their data, which you access in
distinct editors. The Content editor is the main editor for all document types and opens by
default when you open a document. Use data editors to view and manage your documents
and templates.
• User-specific settings: Learn how to customize your PLA 3.0 installation to adapt it to your
requirements.
• Audit trail: Use the audit trail to access details on document-related actions. The audit trail on
the document level contains a subset of the entries available in the system-wide audit trail.
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2 User interface of PLA 3.0
2.1 The Navigator
The Navigator on the left side of the PLA 3.0 main window is the main tool for accessing and
organizing your documents and folders.
Tip: If you work with a large number of documents or a multi-level folder structure, you
can maximize the Navigator by double-clicking its tab. If you prefer a layout similar to Microsoft
Windows File Explorer, click the toggle icon .

Figure 1: The Navigator of PLA 3.0
The Navigator displays your content in two views:
• The top view displays the folders in a tree-like structure. Use it to navigate your folder
structure. Select a folder to display its contents in the detail view.
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• The detail view at the bottom displays the content of the currently selected folder. Use it
to browse your folder contents (documents and templates) and to perform actions on the
selected item.

2.2 Document pane
The document pane on the right side of the PLA 3.0 main window is the main area when
working with documents. When you create a new or open an existing document, it gets
displayed in this pane.
The name of the document is displayed in the header. Below the name, the header also displays
the document key, revision number, and document type.

Figure 2: Document pane of PLA 3.0, displaying the Dashboard of a Quantitative response assay
document
Each document is displayed on a separate tab, with the document name being used as the tab
title. You can open multiple document tabs at a time and switch between them. You can also
drag and drop the tabs to arrange your documents as you require, for example, side-by-side or
below each other.
Tip: To open a document with permission to perform administrative actions, right-click the
document and select Open with elevated permissions.
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2.3 Action bar
Use the action bar on the left side of the document pane to access the editors and the
Dashboard, and perform actions on your documents.

Figure 3: Action bar in the document pane
The content of the action bar depends on the document type and the setup of the document.
The upper part provides links to the document Dashboard, the Content editor, the data editors,
and the document-specific audit trail.
The lower part allows you to perform document type-specific actions such as calculating a
document or applying an electronic signature. The available actions depend on the document
type.

2.4 Dashboard
Use the interactive dashboard to get an overview of your document data and view recent
changes.
On the action bar, the Dashboard is the top-most entry.
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Figure 4: Dashboard of a PLA 3.0 Quantitative response assay document
The contents and layout of the Dashboard depend on the document type and the status of the
document. For example, after a biological assay has been calculated, a graphical summary of
the calculation results is displayed. The contents is organized in sections. You can collapse and
expand each section by clicking on the section header.

9

3 PLA 3.0 databases

PLA 3.0 databases store all your data and also hold information such as user accounts and audit
trail information. When logging in to PLA 3.0, you connect to a specific database, which sets
your work environment for the session.
We recommend you use separate databases for tasks that require different work environments.
For example, use dedicated databases for testing purposes and keep them separate from
production environments.
PLA 3.0 supports local databases, databases shared on a local network, and databases used in a
client-server scenario, thus allowing you to create databases for single users and multiple users
in a shared environment.
You connect to PLA 3.0 databases using database connection profiles. These profiles hold all
properties required to connect to a database such as the path where the database is located, the
user name, and the encrypted password to access the database.
Important: Database connection profiles represent links or shortcuts to a specific database
and are stored independently from the respective database.

3.1 Concepts
Following are the basic concepts that you should be familiar with when working with PLA 3.0
databases.
Database connection profiles

Databases are accessed using connection profiles. Connection profiles are stored
independently from the databases and hold connection details such as the database
location, the user name, and the encrypted password to access the database.

Database templates

Use database templates to quickly create new databases. By default, we provide two
database templates. Both templates contain the required user roles. The 'Default Database
with Demo Data' template additionally contains predefined assay documents to help you
get started. You can use any SQLite database to create additional database templates.

Microsoft SQL Server databases

To manage a medium to a large amount of data that should be simultaneously accessible
by multiple users, we recommend using Microsoft SQL Server as the database server.

SQLite databases

Use an SQLite database if you only have a small amount of data. You can create any
number of SQLite databases. Create the database for the active user or all users of a
computer. To make the database available for a small group of users, you can also place it
in a shared folder or on a file server.
An SQLite database consists of a single database file. Copy, move, and backup actions can
therefore be performed easily. Simultaneous use and remote access are not intended.
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Important: We recommend you regularly create a backup of the database file.

3.2 Create a database
Create a database to store entities such as user accounts, documents, and audit trail information.
Use the Database connection management wizard to create new databases.

Figure 5: Database connection management wizard
The wizard opens automatically when you start PLA 3.0 for the first time. You can also access it
from the Login dialog of PLA 3.0: Click Tools, and select Database management from the
drop-down list. Then, in the Manage database connection profiles dialog, click Add....
You can now perform the following tasks:
• Create a local database: To create a local SQLite database only you want to access, select the
Express mode option.
• Create a shareable database: To create a shareable SQLite database,or a shareable Microsoft
SQL Server database that also allows simultaneous use in a multi-user environment, select the
Standard mode option.
Note: In this mode, you can also connect to existing databases and copy or import
database connection profiles.

3.2.1

Create a local database

Create a local SQLite database if the data should only be accessible by you.
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The database will be created in your Microsoft Windows home directory.
To create a local database:
1. In the Database connection management wizard, select the Express mode option and click
Next >.
2. Enter the details of your new connection profile: Under Database, enter a name for the new
database and select the template you want to use.
We recommend you use the 'Default Database with Demo Data' template.

3. Enter the credentials you want to use for the PLA 3.0 administrator account: Under
Administrator, enter a user name and a password.

Figure 6: Administrator credentials for an SQLite database
If you keep the default credentials, the PLA 3.0 administrator is created as 'Administrator'
without a password.
Important: If you change the default credentials, we recommend you keep your
credentials in a safe place. They are required to manage the database and the user accounts,
and we cannot restore them as they are not known to us.
4. Click Finish.
Results: An information dialog informs you as soon as the database and the corresponding
connection have been set up successfully.

3.2.2

Create a shareable database

Create an SQLite database and make it available for multiple users on a shared folder or a file
server.
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Important: PLA 3.0 supports SQLite as well as Microsoft SQL Server databases. Both
database types allow multiple users to share the access, but only Microsoft SQL Server databases
are intended for simultaneous use.
This procedure describes how to create an SQLite database.
To create a shareable database:
1. In the Database connection management wizard, select the Standard mode option and
click Next >.
2. To make the new database shareable in your network, select the Database profile is
available for all users on this computer check box.
3. Select the Create new database option.
4. From the Type drop-down list, select SQLite and click Next >.
5. Enter the database connection parameters:

Figure 7: Database connection parameters for an SQLite database
a. The database connection profile is created in the path displayed in the Database file text
box. If you require, you can select a different path.

Note: If you change the default path, make sure the new path is accessible by all users
who should be able to connect to the database.

b. In the Description text box, enter a name for the new database and click Next >.

When logging in to PLA 3.0, this name will be displayed in the Database drop-down list.

6. Click Next >.
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7. Select the Standard template option, then select the template you want to use to initialize
the database and click Next >.

By default, two templates are available. Both templates contain the required user roles. We
recommend you use the 'Default Database with Demo Data' template as it already contains
predefined assay documents to help you get started.

8. Enter the credentials that you want to use for the administrative account of the database and
click Finish.
Important: We recommend you keep the credentials in a safe place. They are required
to manage the database and the user accounts, and we cannot restore them as they are not
known to us.

3.3 Initialize an MS SQL Server database
Initialize an empty MS SQL Server database to create a database that can be simultaneously
accessed by multiple users.
• Make sure you are using Microsoft SQL Server version 2012 or higher.
• Make sure you created an empty database that can be initialized by PLA 3.0.
• A Microsoft SQL Server user or domain user with db_owner permission has to be available.
Note: To use the database after it has been initialized, PLA 3.0 user accounts only require
the db_datareader and db_datawriter permissions.
To initialize an MS SQL Server database:
1. In the Database connection management wizard, select the Standard mode option and
click Next >.
2. Select the Connect to existing database option.
3. From the Type drop-down list, select Microsoft SQL Server and click Next >.
4. Enter the database connection parameters:

14
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Figure 8: Database connection parameters for an MS SQL Server database
a. From the Server name drop-down list, select the server that holds the empty database.

If the server you require is not displayed, you can manually enter the name or IP address
of the server.

b. In the User name and Password text boxes, enter the credential of the MS SQL account
with db_owner permissions.

c. From the Database name drop-down list, select the empty database you want to initialize.

5. Click Next >.
6. Verify the connection details and click Finish.
7. Select the Standard template option, then select the template you want to use to initialize
the database and click Next >.

By default, two templates are available. Both templates contain the required user roles. We
recommend you use the 'Default Database with Demo Data' template as it already contains
predefined assay documents to help you get started.

8. Enter the credentials that you want to use for the administrative account of the database and
click Finish.
Important: We recommend you keep the credentials in a safe place. They are required
to manage the database and the user accounts, and we cannot restore them as they are not
known to us.
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3.4 Manage database connections
A database connection profile holds all properties required to connect to a database such as the
path where the database is located, the user name, and the encrypted password to access the
database.
Important: A database connection profile is a shortcut or link to a database, not a database
itself.
Use the Manage database connection profiles dialog to manage database connections.

Figure 9: Manage database connection profiles dialog
To access this dialog: In the Login dialog of PLA 3.0, click Tools, and select
management from the drop-down list.

Database

You can now perform the following tasks:
• Create a database: To add a connection profile for a new local or shareable database, click
Add.... You can add any number of database connection profiles.
• Modify the parameters of an existing database connection profile: From the Database
connection profiles list, select the respective profile and click Edit....
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• Export a database connection profile: To distribute a database connection profile to other PLA
3.0 installations, from the Database connection profiles list, select the respective profile and
click Export....
• Connect to a database: From the Database connection profiles list, select the respective
profile and click Connect.

3.4.1

Export a database connection profile

Export a database connection profile to distribute the respective database connection to other
PLA 3.0 installations.
To export a database connection profile:
1. On the source computer, in the Login dialog, click Tools.
2. From the drop-down list, select

Database management.

3. In the Manage database connection profiles dialog, select the respective profile and click
Export....
4. In the Export database connection profile dialog, complete the following steps:

a. In the Target path text box, click [...], navigate to the directory where you want to save
the profile, and click OK.

b. In the File name text box, enter a name for the database connection profile.

Figure 10: Exporting a database connection profile
5. Click OK.
6. Make the resulting database connection (.DBConnection) file available on the computer on
which you want to import the database connection.

3.4.2

Import a database connection profile

Import an existing database connection profile to connect to a database using the connection
parameters of the imported profile.
To import a database connection profile:
1. In the Login dialog, click Tools.
2. From the drop-down list, select
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Database management.

3. In the Manage database connection profiles dialog, click Add....
4. In the Database connection management wizard, select the Standard mode option and
click Next >.
5. Select the Import database connection option.
6. In the Profile text box, click […], navigate to the profile you want to import, select it, and click
Open.

Figure 11: Import a database connection profile
7. Click Finish.

3.5 Connect to a database
Connect to a database to work with the data.
When you log in to PLA 3.0, the Database drop-down list contains all databases you can
connect to. If the database you want to use is not displayed, you have to set up the respective
database connection by creating a new database connection profile.
1. In the Login dialog, click Tools.
2. From the drop-down list box, select

Database management.

3. In the Manage database connection profiles, click Add....
4. In the Database connection management wizard, select the Standard mode option and
click Next >.
5. Select the option that suits your needs:
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◦ To connect to an existing database using the connection details from a database
connection (.DBConnection) file, select Import database connection.
◦ To connect to an existing database, select Connect to existing database. Then, from the
Type drop-down list select the type of database you want to connect to.
◦ To create a new database and corresponding database connection profile, select Create
new database.
◦ To copy an existing connection, select Copy connection.

3.6 Creating configuration reports
A configuration report (also referred to as configuration item list or CIL) summarizes the
configuration of the database as it is presented to the user who creates the report.
Depending on the size of the database and the amount of included information, creating a
configuration report can take several minutes.
To create a configuration report, you need at least the 'Edit database policies' permission.
To create a configuration report:
1. Open the System menu, and click

Configuration report.

2. In the Create configuration report dialog, on the Settings tab, configure the report.

a. Select the folder where the report should be saved: Click Select target folder […] and
navigate to the respective folder.

b. Select the information you want to include in the report.

Note: Some additional information is always included in the report, for example, the user
who created the report or general information on the database.

3. To create the report, click the Start button.
Results: The report is created. The status bar at the bottom of the dialog shows the progress.
4. To view the resulting PDF, click Report.

3.6.1

Configuration report options

Table 1. System
Option

Description

Required permission

License information

Reports information on all
PLA 3.0 licenses available for
the currently logged-in user.

No additional permission
required.
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Environment

Reports system information,
for example, the PLA
3.0 installation directory
and Microsoft Windows
environment variables,
which are visible to the
currently logged-in Microsoft
Windows user.

No additional permission
required.

Plug-Ins

Reports information about
installed plug-ins and their
configuration.

Manage component
packages

Option

Description

Required permission

Database policies

Reports information on
the Policy settings of the
database.

Edit database policies

Component packages

Reports information on
the component packages
installed in the database.

See component packages

Option

Description

Required permission

Document restrictions

Reports information on the
document restrictions that
can be set using the folder
properties. Only folders
for which the user has the
required permission are
included in the report.

Read folder properties

Document key formats

Reports information on
the document key format
settings that can be set using
the folder properties. Only
folders for which the user has
the required permission are
included in the report.

Read folder properties

Table 2. Database configuration

Table 3. Configuration contexts
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Security contexts

Reports information on the
security contexts that can
be viewed using the folder
properties or the dialog to
change the security context.
Only folders for which
the user has the required
permission are included
in the report. If the user
has permission to manage
accounts, all security contexts
are reported.

Read documents or Manage
accounts

Path information of security
contexts

Reports path information
for the reported security
contexts.

Read documents or Manage
Accounts

Option

Description

Required permission

Users

Reports information on all
users set up in the database
as well as the assigned
groups, global roles, and
document roles.

Manage accounts

Groups

Reports information on
all groups set up in the
database as well as the group
members, assigned global
roles, and document roles.

Manage accounts

Effective privileges of users
and groups

Reports all effective
privileges of the assigned
global roles and document
roles to the users and groups
report.

Manage accounts

Global roles

Reports information on all
global roles configured in the
database.

Manage accounts

Document roles

Reports information on all
document roles configured in
the database.

Manage accounts

Table 4. Account management
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Table 5. Statistics
Option

Description

Required permission

Document statistics

Reports a statistic of the
documents on which the user
has the required permission.

Read documents
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4 Documents

PLA 3.0 stores all your data in electronic documents. Documents are stored in a database and
displayed in a folder structure. They are structured to suit specific applications, represented by
document types. Each document contains a set of elements, with each element holding specific
data. The complete set of elements creates the document structure.
Documents and templates
You can use documents for different purposes. Use standard documents to store your data.
When setting up the experiment configuration, for example, you can use documents to define
setups for assay samples, analysis, and test systems.
Use templates to provide initial values for your documents or apply protection settings to
document elements. In contrast to standard documents, templates should not contain any data
and can therefore not be calculated. You can identify templates by an orange square in the
upper right corner of the document icon ( ).

4.1 Working with documents
4.1.1

Creating documents

Create documents to store your data.
Note: This procedure describes how to create a document from scratch. For help on how to
use templates, please consult the respective guide.
To create a document:
1. In the Navigator, right-click the folder in which you want to create the document.
2. From the context menu, select

New.

Tip: This action is available in the top and the detail view of the Navigator.

3. In the Create a new document dialog, on the Available document types tab, select the
document type you want to create.
Which document types are available depends on the document packages activated in
your database. In the example below, we use the 'New Quantitative Response Assay <No
Template>' document type to create a new Quantitative response assay.
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Figure 12: Creating a new Quantitative response assay
4. To confirm your selection, click Create.
Results: The Content editor opens, displaying your new document.
5. Enter a document name.

We recommend you enter a meaningful document name, as this makes it easier for you to
search for existing documents later.
Note: For some document types, the name is automatically generated and cannot be
changed.

6. Save the document.

4.1.2

Renaming documents

You can rename a document anytime. As documents are identified by their document keys,
renaming a document does not impact existing references.
Note: Calculation results are discarded upon renaming.
To rename a document:
1. Open the document you want to rename.
2. In the Element pane, click the current name.
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3. Enter the new name and save the document.

4.1.3

Setting element values

4.1.3.1

Enter values

Set up your document by entering values for document elements. For some elements, you can
enter a value such as text, or a date. Other elements serve to provide structure for subelements.
To enter element values:
1. In the Element pane of the Content editor, navigate to the element and select its current
value.

Tip: To quickly find elements by their name, use the Find and filter dialog: Open the Edit
menu, and click Find. Enter your filter criterion and click Filter.

2. Enter or select the new value and hit Enter on your keyboard to confirm it.

PLA 3.0 has several control types to enter values for example a simple input box to type in a
number or text. An icon in the central pane of the Content editor indicates what type of value
you can enter for an element.
Table 6. The following table lists some common control types:
Data type
Color

Select a color from the color catalog or enter an RGB value to
define a color.

Data set

Shift-click the entry to open the respective data set.

Date

Enter a date or use the arrow buttons to select a date.

Date and time

Enter a date and time or use the arrow buttons to select a date
and time.

Double

Enter a double-precision value.

Integer

Enter an integer number.

List

Select an entry from the drop-down list.

Multi-line text

Enter multiple lines of text.

No value /unknown
type
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Description

Indicates a summary element. In the case of reference elements,
allows you to add a reference to another element in the same
document.

Reference

Add a reference to another document.

Text

Enter a single line of text.

Time

4.1.3.2

Enter a time or use the arrow buttons to select a time.

Reference elements

Some elements require a reference to another element. This allows you to set up an element
once and reuse it several times within the same document.
You can identify elements that require a reference to another element by a link in the Value
column. In the following example, the Preparation scheme and the Data selection scheme
elements reference other elements:

Figure 13: References to Preparation and Data selection scheme in a Quantitative response assay
The reference is set automatically if there is only one instance of the element to be referenced. If
there are several instances, you have to manually select the instance you want to reference.
To add a reference to another element:
1. In the Value column of the element for which you want to create a reference, click the current
entry.
Results: A drop-down list with all available element instances is displayed.
2. From the drop-down list, select the element you want to reference.

Tip: You can also right-click the element itself and use the Select target for entry to
select the element you want to reference.
3. Save the document.

4.2 Organizing documents
Create folders and subfolders to organize your documents and to set up a folder structure that
suits your needs. Move, copy and delete folders and documents to adapt your folder structure if
required. Organizing documents requires sufficient permissions.
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Note: You can also use folders to set up document-related permissions and to enforce the
use of templates for specific folders or document types.
Table 7. To organize documents, the following actions are available. Access these actions from
the context menu of the Navigator, the File menu, or the toolbar.
Action

Description

New folder

Creates a new subfolder in the selected folder. The new folder inherits
the security settings and folder attributes of its parent.

Move

Moves the selected document, template, or folder to a different
folder, retaining the document and folder keys. You can use an
existing folder as the target folder or create a new folder.

Copy

Copies the selected document, template, or folder. The copies receive
new keys. You can create a copy in the same or a different folder, or
you can create a new folder for the copies.

Delete

Deletes the selected document, template, or folder.
Important: Deleted documents and folders cannot be restored.

4.2.1

Navigate contents

4.2.1.1

Navigate your folder structure

Use the top view to organize your documents and to navigate your folder structure.
This view displays your folders in a tree-like structure. The breadcrumbs in the header bar of the
Navigator display your current position in the folder structure. Click on a breadcrumb to jump
to the respective folder.
To navigate your folder structure, you have the following options:
• Select a folder to display its contents in the detail view.
• Double-click a folder to expand or collapse its content.
• Right-click a folder to access context-specific actions such as move and copy.

4.2.1.2

Navigate your folder content

Use the detail view at the bottom to perform actions on the content.
This view displays content (subfolders and documents) of the currently selected folder as well
as additional information such as the key to uniquely identify a document or folder, and the last
modification date.
Tip: By default, the detail view is located below the tree view. If you prefer a layout similar to
Microsoft File Explorer, click the toggle icon .
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To navigate your folder content, you have the following options:
• To sort your content, click the column header according to which you want to sort. The sort
order is set to ascending on the first click, to descending on the second click.
• To start working on a document, double-click it.
• To display additional information in the status bar, such as the security context or document
type, select a document.
• To perform the same action on several documents or folders, control-click the documents or
folders, right-click your selection, and select one of the context-specific actions.

4.2.1.3

Filter your contents

Apply filters to restrict the number of documents and folders displayed in your folder structure.
The header bar of the Navigator, next to the breadcrumbs, provides various options to filter
your content.

Figure 14: Filter options in the header bar of the Navigator
When applying a filter, the Navigator hides folders that do not contain matching documents. To
reset your filter, click Reset filter settings.
To filter contents, you have the following options:
• The free-text filter on the left is based on the document title or document key. To use this filter
option, enter your filter criterion in the <Enter filter> text box.
• To use one of the predefined filters, click Filter settings, select your filter criteria, and
click Apply. For example, you can display signed documents only, documents of a specific
document type, or documents that were modified in the previous month.

Tip: You can combine a free-text filter with a predefined filter. For example, you can search
for signed documents (predefined filter) with 'parameter' in the title (free-text filter).

4.2.2

Exporting documents

Use the document export and import functionality to exchange documents between different
PLA 3.0 environments.
You can export a single document, all documents in a folder, or a complete folder structure.
Documents are exported and imported using document packages (*.edpdp files). Document
packages are cryptographically secured and therefore protected against modifications. This
ensures that your data remains unchanged, electronic signatures are untouched, and folder
structures are preserved.
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Important: Document packages used for document export and import are different from
document packages used to thematically group document types.

4.2.2.1

Export a single document

Export a single document to make it available in another PLA 3.0 environment.
To export a document:
1. In the detail view of the Navigator, right-click the document you want to export.
2. From the context menu, select Export >

Documents.

Tip: If the Documents submenu is grayed out, check if the document is open in a data
editor. If yes, close the document.

3. In the Export as document package dialog, on the Settings tab, select the folder to which
you want to export the document package and click Save.

Important: If you change the default file name, make sure to keep the file type (*.edpdp).
If you change the file type, you cannot export the document package.

4. To export the document and create the document package, click Start.

4.2.2.2

Export a folder structure

Export a folder structure to preserve the organization of the contained documents when making
them available in another PLA 3.0 environment.
To export a folder structure:
1. In the Navigator, right-click the folder that contains the structure you want to export.
2. From the context menu, select Export >

Documents.

Tip: Open documents are excluded from the export process. Make sure all documents in
the structure are closed.

3. In the Export as document package dialog, on the Settings tab, select the folder to which
you want to export the structure and click Save.

Important: If you change the default file name, make sure to keep the file type (*.edpdp).
If you change the file type, you cannot export the folder structure.

4. To export the folder structure and create the document package, click Start.

4.2.3

Importing documents

4.2.3.1

Import a document

Import a document to make it available in your PLA 3.0 environment.
To import a document:
1. In the Navigator, right-click the folder to which you want to add the document.
2. From the context menu, select
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Import....

3. In the Importing documents dialog, select 'Document package' and click OK.
4. In the Import documents dialog, on the Settings tab, select the document you want to
import as the source file and click Open.

Important: If the source file you selected is not displayed and Start is grayed out, check
the file type of the source file. PLA 3.0 can import only documents with the (*.edpdp) file type
in lower case.

5. To import the document, click Start.

4.2.3.2

Import a PLA 2.x document

Import a PLA 2.x document to make it available in your PLA 3.0 environment.
Note: This procedure describes how to manually import a PLA 2.x document. To migrate
your data from PLA 2.x to PLA 3.0, we recommend you use our PLA Migration and Archiving
Toolkit.
To import a PLA 2.x document:
1. In the Navigator, right-click the folder to which you want to add the document.
2. From the context menu, select

Import....

3. In the Importing documents dialog, select 'PLA 2.x (*.psf) Documents' and click OK.
4. In the Import data dialog, on the Settings tab, select the PLA 2.x document you want to
import as the source file and click Open.
5. To import the PLA 2.x document, click Start.

4.2.4

Change document keys

Documents, templates, and folders are identified by unique keys. The key consists of a prefix, a
counter, and a suffix. You can change the counter if required.
Important: You cannot change the format of the document key with this action. To change
the format, you have to change the properties of the folder that contains the document.
Make sure your database policies allow changes to document and folder keys.
To change document keys, you need the 'Change document and folder key' permission.
To change the counter of a document key:
1. In the detail view of the Navigator, right-click the document for which you want to change
the key.
2. From the context menu, select Advanced >

Change document key.

3. In the Change document key dialog, under Document key, select if the new key should be
generated automatically or if you want to enter it manually.
4. If you manually enter a new key, in the Custom number text box, enter the new counter.
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5. If the document key displayed in the preview meets your requirements, click OK.

4.3 Perform document actions
4.3.1

Document actions

PLA 3.0 provides a set of actions you can perform on documents and document data. The
actions you can perform depend on the document type.
When you start an action, a progress dialog shows the current status of the action. Once the
action is completed, you can save a report and a log file of the action in PDF format.
Tip: To automatically close the progress dialog after the action was successfully completed,
activate the Close dialog after task completion option in your preferences.
Table 8. The following table lists all possible actions (in alphabetical order):
Action

Description

Acquire data

If a Data Acquisition Module is activated in your database, you can
acquire data from an external source.

Calculate

Starts the calculation of the document.

Export tests

Exports the tests of an Equivalence margin development
document.

Refresh control chart

Refreshes the calculation of a Control chart document.

Report

Creates a document type-specific report.

Signatures

Allows you to apply electronic signatures to a document, the data
area of a document, or the content of a document.

Upgrade structure

Upgrades the structure of a document as required by the currently
active document package version.

4.3.2

Calculating documents

After you entered the response values and finished the setup of your document, you can
calculate the reportable values.
Note: Depending on the complexity of the document setup, the calculation time can vary
from seconds to several minutes.
To calculate a document:
1. On the action bar, click

Calculate.

Note: For Control chart documents,
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Refresh control chart starts the calculation.

Results: The Calculation dialog shows calculation details and informs you about the progress.
The calculation result is displayed in the yellow status bar at the bottom of the dialog.
2. Click Close.
• To view a graphical summary of the calculation results, open the dashboard: On the action bar,
click Dashboard.
• To generate a detailed PDF report with the calculation results, on the action bar, click
Report.

4.3.3

Creating reports

4.3.3.1

Create reports for a single document

Reports are created as PDF files and summarize the details and the results of an action that was
executed on a document. You can view the files in your default PDF viewer, print them out, or
save them.
To create a report for a single document:
1. On the action bar, click

Report.

2. In the Create reports dialog, on the Reports tab, configure the report.

a. From the Action drop-down list, select what should be done with the created report. You
can show the report in your default PDF viewer, print the report on your default printer, or
save the report in the target folder.

b. If you want to save the report, select the respective folder: Click Select target folder […],
and navigate to the respective folder.
c. In the Reports area, select the layout template you want to use for the report. You can
select multiple templates for the same document. For each selected template, one report
is generated.

Example: In the following example, two reports are created for a Quantitative assay document
(an Advanced detailed report and a Detailed report) and saved in a local folder.
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Figure 15: Selection of report templates
3. To create the reports, click Start.
Results: The reports are created. The status bar at the bottom of the dialog shows the
progress.

4.3.3.2

Create reports for multiple documents

Instead of creating a report for each document, you can create reports for multiple documents
at the same time. The documents can have different types and can belong to different document
packages.
Note: Documents in a set that do not support the creation of reports are skipped.
To create reports for multiple documents
1. In the detail view of the Navigator, control-click the documents for which you want to create
a report, right-click your selection, and select Create report.
2. In the Create reports dialog, on the Reports tab, configure the reports.

a. From the Action drop-down list, select what should be done with the created reports. You
can show the reports in your default PDF viewer, print the reports on your default printer,
or save the reports in the target folder.

b. If you want to save the report, select the respective folder: Click Select target folder […],
and navigate to the respective folder.
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c. In the Reports area, select the layout templates you want to use for each report. Select
at least one template for each document type. For each selected template, one report is
generated.

Example: In the following example, three reports are created (one for each document type)
and opened in the default PDF viewer.

Figure 16: Selection of report templates for multiple documents
3. To create the reports, click Start.
Results: The reports are created. The status bar at the bottom of the dialog shows the
progress.

4.3.4

Signing documents

When the work on your document is finished, you can sign it to prevent further change.
Electronic signatures in PLA 3.0 are compliant with 21 CFR part 11.
You can apply signatures to different areas of the document:
• Document: If you sign the whole document, it will be displayed read-only.
• Content: If you sign the content area, the document structure will be displayed as read-only.
• Data: If you sign the data area, the data editors will be displayed as read-only.
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Note: Signing documents requires the 'Apply electronic signature' permission.
To sign a document:
1. On the action bar, click

Signatures.

2. In the Electronic signatures dialog, click

Apply signature.

3. In the Apply electronic signature dialog, enter the following signature-related information:

a. Area: Select the area that you want to sign. In this example, you sign the whole document.

b. Template: Select the reason why you want to sign the document. You can use one of the
provided templates, or you can describe the reason in the Meaning text box.
c. Password: Enter your password.

Figure 17: Apply electronic signature dialog
4. To confirm the signature, click Apply.
Results: Your signature is listed in the Electronic signatures dialog.
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Figure 18: Electronic signatures dialog
5. Click Close.
Results: In the Content editor, the yellow information bar displays a corresponding message.

Figure 19: Information bar of a signed document

4.3.5

Upgrading the structure of documents

If a newly activated document package version requires a different document structure, you have
to upgrade your existing documents.
You can edit documents only if they follow the structure required by the currently active package
version.
You can upgrade the structure of an individual document or all documents in a folder. You can
also create upgraded copies of your documents instead of upgrading the originals. Upgrading a
document structure removes all results from the document and, if your database policies allow
it, also all signatures.
Important: Structure upgrades cannot be reverted.
To upgrade all documents in a folder:
1. In the Navigator, right-click the folder that contains the documents you want to upgrade.
2. From the context menu, select Advanced >

Upgrade structures in folder.

3. In the Upgrade document structures dialog, set up the upgrade logic.

a. Select the document modes you want to upgrade. The document mode determines
the purpose for which the document is used. You can upgrade documents, document
templates, performance qualification (PQ) definitions, or any combination of the three.
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b. Select whether you want to create upgraded copies or upgrade the original documents.

c. By default, signed documents are excluded from the upgrade process. If your database
policies allow signature removal, you can include signed documents: Select the Upgrade
signed documents check box and enter your login credentials.
Note: This option is available only if you upgrade the original documents. If you
do not have the permission required to remove signatures, signed documents are still
excluded.

4. To start the upgrade process, click Proceed.
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5 Templates

Templates simplify tasks, standardize processes, and improve data security. They allow you to
define document structures that are frequently needed, for example, to match the setup of an
assay that is frequently run.
Templates also allow you to define initial values to be set in documents. And they enable you
to exercise very fine-grained control over who can view and edit document sections and even
individual data elements within documents.
You can identify templates by an orange square in the upper right corner of the document icon
( ).
Method lifecycle
Templates support your method lifecycle from early stages to development and operation.
Develop your methods using documents. Enforce your Standard Operation Procedures and
implement your methods by saving your documents as templates.
Development mode

Operation mode

Figure 20: Method lifecycle in PLA 3.0
• In development mode, functional administrators develop methods by setting up assay
elements, the analytical methods, and the test system in a document. This configuration
document is saved as a template to implement the method.
• In operation mode, operators and end users with restricted access utilize the templates
created during development for use with experiment runs. Commonly, a template is
configured to suit several experiment runs without additional configuration needed by the
operating user. An operating user should only need to enter the experiment data, run the
calculation, and report the results.

5.1 Creating templates
Use templates to create a set of documents with the same configuration settings. Documents
created based on a template inherit the template's configuration settings such as initial values or
protection settings for document elements.
To create a template, you have the following options:
• Save an existing document as a template: Open the document, open the File menu, and click
Save as template.
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Note: You have to manually remove observations and annotations from the template.
• Create a new document and, on the Available document types tab, select the Create as
template check box.
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6 Editors
6.1 Working with the Content editor
6.1.1

Content editor

PLA 3.0 provides several views on documents and their data, which you access in distinct editors.
The Content editor is the main editor for all document types and opens by default when you
open a document.
Use this editor to navigate the document structure, and to view and maintain document
elements and document data. On the action bar, the Content editor is located below the
Dashboard.
Tip: To maximize the editor, double-click the tab.

Figure 21: Content editor (Quantitative response assay document)
The toolbar at the top of the editor provides shortcuts to document element-related actions (left
side) as well as options to customize the display of documents (right side). The breadcrumbs
allow for quick navigation.
Below the toolbar, the following panes are available:
Outline pane

Located on the left side, this pane displays a hierarchical outline of the document
structure. Use this pane for navigation and to quickly access document elements.
Tip: Use Zoom and Highlight from the View options to customize how elements you
select in the Outline pane are displayed in the Element pane.
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Element pane

The central pane shows the document structure (document elements and child elements)
and element values. Use this pane to enter values, or edit the values of elements and child
elements.
Tip: Use plus (+) and minus (-) or Expand ( ) and Collapse ( ) from the toolbar to
show or hide elements as you require.

Createable elements pane

Located on the right side, this pane lists additional elements you can add to your
document structure. This list changes when you select another element in the central or
left pane. Double-click an entry in this list to add the element to your current context.
Tip: Double-click an entry from the Favorites list to add a commonly used element,
independent of your current context.

6.1.2

Customize the document view

Use the View options drop-down list in the toolbar to customize the view on documents and
document data.
With the setup shown below, breadcrumbs and all panes of the Content editor are available.
Deselect an entry to hide the respective view.

Figure 22: View options in the Content editor
Zoom and Highlight
The Zoom and Highlight options allow you to customize how elements you select in the Outline
pane are displayed in the Element pane:
•

Zoom: Displays all subelements of the selected element. Parent elements (elements on
higher levels) and sibling elements (elements on the same level) are hidden.

•

Highlight: Highlights the element in the document structure. Parent and sibling elements
are displayed in a lighter color.

Tip: You can reset the user interface to the default setup: Open the Help menu, and click
Reset user interface.
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6.1.3

Set up documents

6.1.3.1

Create elements

Create additional document elements to adapt the document structure to your requirements.
To create elements, you can use one of the Content editor panes or the Create... shortcut in the
toolbar. In all cases, you can add elements to your current context or select from a list of favorite
elements.
In the following examples, the Additional calculations element is added to the Analysis node
of a Dose-response analysis document.
Use the Outline and Element pane
Right-click an element and select Create element > Context. Then select the element you want
to add.

Use the Createable elements pane
Double-click the element you want to add.

6.1.3.2

Create references between elements

Some elements work as target elements; you set them up once in your document and reference
them several times.
To create a reference between elements, you can manually create the target element and
reference it from the source element. You can also use the Create target menu to create a target
element and reference it in one step.
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In the following example, we create an additional Single-dose preparation scheme and link it to
a Test sample in a Dose-response analysis document.
To create a target for an element:
1. Right-click Preparation scheme and select Create target for Test: TST1....

Figure 23: Creating a target element for Test sample TST1
2. As the target, select 'Preparation scheme', and click Create.
Results: A second Single-dose scheme is created and automatically assigned to the Test
sample.

Figure 24: Newly created target element for Test sample TST1

6.1.3.3

Create references to documents

Some elements are set up such that they reference other documents. This allows you to define a
central set of documents that can be reused in other documents. The referenced document and
the document referencing it can be of different document types.
When working with biological assays you can, for example, describe the substance that is used in
your assays in a central Substance document and reference this document in all assays that use
this substance.
You can identify elements that require a reference to another document by the link icon in
the data type column. In the following example, the Substance reference element references a
document:
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Figure 25: Reference to a Substance document
Tip: You can view and manage all document references in a central Document references
dialog. On the toolbar of the Content editor, click References.... to display all currently
referenced documents. Depending on the configuration of the reference you can perform a set
of actions, for example, create a new reference, select a different target document, or highlight
the referencing element in the Content editor.
To add a reference to a document:
1. In the Value column of the element for which you want to create a reference, click the entry.
2. On the toolbar, select if you want to reference an existing document or create a new
document.
◦ To select an existing document, click . In the Document reference dialog, navigate to
the document you want to reference, select it, and click OK.
◦ To create a new document, click . In the Create a new document dialog, select the
document type you want to use and click Create. Shift-click the new document to open it,
set it up as you require, and save it.
3. Save the original document.

6.1.3.4

Remove elements

If an element is not required in your document structure or if you accidentally added an element,
you can remove it.
Important: Some elements are mandatory for a document type. You cannot remove these
elements.
To remove an element from the document structure:
1. In the Element pane, right-click the element you want to remove.

Note: Removing an element from the Outline pane is not possible.

2. From the context menu, select

6.1.4

Delete.

Troubleshoot your document setup

When you modify your document structure or add values to your elements, PLA 3.0
automatically validates your document and displays additional information to support you
during the setup process.
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The Help view displays additional information about an element. This view is available in all
editors. To open it, click

Help in the action bar.

Figure 26: Help view of a Contact element
Tip: Use Ctrl + and Ctrl - to zoom in and out of the help text.
If an error occurred, additional information is available in the Error view. This view is available in
all editors. To open and close this view, click

Errors in the action bar.

Figure 27: Error view of a Quantitative response assay
Tip: Both buttons are toggle buttons. Use them to open and close the respective view.

6.2 Working with data editors
6.2.1

Data editors

Use data editors to view and manage your documents and templates. Each editor provides a
different view on your data.
Data editors support a variety of use cases. Which editors are available depends on the
document type and the document setup. You can access the available editors using the action
bar of the document pane.
The following data editors are available:
Observations editor
By Sequence editor
By Position editor
References editor

6.2.1.1

Observations editor

Use the Observations editor to enter the raw data.
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The Observations editor displays the observation data of the assay row by row. Each row
displays the data of one observation. Each column displays one property of the corresponding
observation.

Figure 28: Observations editor of a Quantitative response assay document

6.2.1.2

By Sequence editor

Use the By Sequence editor to enter dilution sequences.
The By Sequence editor displays the sequence step number as it has been calculated based on
the preparation scheme.
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Figure 29: By Sequence editor of a Quantitative response assay document

6.2.1.3

By Position editor

Use the By Position editor to set up a plate layout.
The By Position editor displays the observation data in a table that resembles a microplate, for
example, a 96-well plate.
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Figure 30: By Position editor of a Quantitative response assay document

6.2.1.4

References editor

Use the References editor to retrieve observation data from referenced documents.
Important: As the original data is retrieved from the referenced documents, you can edit
only a subset of this data. For example, you can decide if a value should be treated as a technical
outlier. Data values that you cannot modify are grayed out.
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Figure 31: References editor of a Combination of assay results document

6.2.2

Working with data editors

6.2.2.1

Copy and paste data

You can cut, copy, paste, and delete your data.
Table 9. Use the options as follows:
Option
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Description

How-to

Cut

Cuts the data from one or more
cells, rows, or columns and transfer
it to another data editor, another
document, or an external program.

Right-click the data you want to
cut and select Cut from the context
menu.

Copy

Copies your data between data
editors, to another document, or an
external program.

Right-click the data you want to
copy and select Copy from the
context menu.

Paste

Pastes data you cut or copied
before to another data editor, or an
external program.

Right-click the position where you
want to paste the data and select
Paste from the context menu.

Delete

Deletes one or more values from
one or more cells, rows, or columns.
Important: You can delete
data from single editable cells or
multiple editable cells only if the
cells form a rectangular shape.

6.2.2.2

Right-click the data you want to
delete and select Delete from the
context menu.

Edit a single cell or multiple cells

Each editor contains two work areas. Use these work areas to edit the data of a single cell or
multiple cells at a time.
Edit a single cell
The work area at the top displays your data in a grid-like table structure. Use this work area to
edit a single data entry:

Figure 32: Editing a single cell in the Observations editor
Edit multiple cells
The work area at the bottom displays details of the entry you selected in the table. Use this work
area to work on multiple data at the same time (multi-cell editing):
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Figure 33: Editing multiple cells in the Observations editor

6.2.2.3

Open your data externally

You can display your data in your standard editor for .csv files.
Note: We recommend you verify the formatting of the transferred data and correct the
imported values if required. For example, Microsoft Excel automatically reformats the ratio 1:50
to the time stamp 1:50:00.
To open your data externally:
1. Open one of the data editors.
2. From the toolbar of the data editor, select

6.2.2.4

Open externally.

Select a coloring scheme for your data

Each editor provides a set of coloring options you can use to visualize the behavior of your data.
To select a coloring scheme:
1. From the toolbar of the data editor, select View options > Grid color.
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2. Select the coloring scheme you want to apply. You can color by sequence step, by response
value, or by technical outlier. The brighter the color, the lower the associated value.

Figure 34: Grid colors in the data editors

6.2.2.5

View annotations

Annotations provide additional details about specific actions performed on data values. You can
view these annotations from any data editor.
Annotations are created for values that were acquired using a Data Acquisition Module as well
as for values for which the technical outlier state is changed. You can identify an annotated value
by a small blue triangle in the upper left corner of the data cell.
To view the annotation of a value:
1. Right-click the annotated data.
2. Select

Show annotations from the context menu.

6.2.3

Entering observation data

6.2.3.1

Enter your data manually

You can manually enter your observation data, row by row.
To enter observation data manually:
1. Open the Observations editor.
2. Retrieve the assay element values you configured in the Content editor: From the
Assignments drop-down list, select Sequence > Observation Group ID -> Sequence Step
3. Click Add or
you require.

Remove to add additional observation data or remove unwanted entries if

4. Fill in your measurement data: Select each cell in the Response column and enter a response
value for the corresponding sequence step.
Note: If you use a Data Acquisition Module, the module fills the responses from the first
position to the last one.

5. Save your document.

6.2.3.2

Aggregate data from other documents

Instead of manually adding your observation data, you can retrieve and aggregate data from
referenced documents.
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How document references and the data provided by the referenced documents are updated
depends on the update mode you selected for your observation data in the Content editor.
Table 10. The following update modes are available:
Mode

Trigger

Scope

Auto all

Updates automatically when you
open or close the document.

Searches the entire database for
data matching the property filter.
Updates all matching data and
the list of referenced documents.

Auto data

Updates automatically when you
open or close the document.

Updates data from currently
referenced documents.

Manual all

Updates when you manually
refresh the references in the
References editor.

Searches the entire database for
data matching the property filter.
Updates all matching data and
the list of referenced documents.

Manual data

Updates when you manually
refresh the references in the
References editor.

Updates data from currently
referenced documents.

To set up references to documents:
1. Open the References editor.
2. To add new document references: How you can do this depends on the update mode you
selected for your observation data in the Content editor.
◦ If you selected 'Manual data' or 'Auto data', click Add reference and use the Reference
dialog box to select the documents that you want to reference.
◦ If you selected 'Manual all' or 'Auto all', click Refresh references. All documents are
retrieved from the database that match the data aggregation filters you defined in the
Content editor.
Results: In the References editor, the data of the documents you selected is displayed. For
each document section, one line is displayed. In the case of Quantitative response assays,
each assay element is considered to be a section.
3. To update existing document references:
◦ If you selected a manual update mode in the Content editor ('Manual data' or 'Manual
all') you have to manually update existing references to retrieve the latest data.
◦ If you selected an automatic update mode ('Auto data' or 'Auto all'), the referenced data is
updated automatically when you open the document.
4. Click

Remove references to remove unwanted entries if you require.

Important: If a referenced document has several sections and you remove one of these
sections, all the other sections are removed as well.
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5. Save your document.

6.2.3.3

Acquire data from instruments

You can acquire your observation data from an external source, for example, from a third-party
manufacturer.
Important: To acquire data, you have to activate the Data Acquisition Module required for
your source files.
The following figure gives an overview of the general process:
PLA 3.0

Vendor data acquisition system

Observations
editor

Data Acquisition
Module

Vendor software

Instrument

Figure 35: Data acquisition process in PLA 3.0
Data acquisition in PLA 3.0 allows you to import response values from external systems into
existing PLA 3.0 documents. The acquired values are imported with traceability information (time
stamp of the acquisition, the user who acquired the data, and original value) and details about
the source file as well as the Data Acquisition Module used. Response values imported from an
external system are available in the Observations editor of the document.

6.2.4

Setting up a plate layout

As an alternative to entering your observation data using the Observations editor, you can enter
your observation data based on the layout of the plate that you used to perform the assay.
Note: This procedure provides an overview only. For details on all steps, please consult the
respective guide.
To enter your data based on a plate layout:
1. Use the Observation data node of the Content editor to define your plate size. Add two
positions to set up one plate or three positions to set up multiple plates.
2. Use the Observations editor to assign your observation data to the rows and columns of
your plate.
3. Use the By Position editor to define how your samples are arranged on your plate.
4. Use the By Position editor to add your response values to the plate.

54

User Guide | PLA Version 3.0.4

7 User-specific settings

Manage your personal settings to adapt the behavior of PLA 3.0 to your requirements.
PLA 3.0 can be configured on database level and on user level. Settings on database level are
valid for all PLA 3.0 users. Settings on user level are valid only for the who performs the settings.
Use the following entries from the System menu to manage your personal settings:
•

Preferences

•

My account

•

Change password

7.1 Configuring your preferences
Configure the preferences of your PLA 3.0 installation.
Table 11. General tab
Setting

Description

Application paths

Defines default paths for importing and exporting files or documents.
To change the default paths, click ….

Internet access

Defines the logic according to which PLA 3.0 connects to the internet.
You can perform the check automatically or manually when PLA
3.0 starts, or you can deactivate the check. This setting is used, for
example, when checking for news and updates or downloading an
information package.

Proxy

If PLA 3.0 should use a proxy server to access the internet, select the
Activate check box and enter the address and the port of the proxy
server. To test the connection to the server, click Test.

Navigator

Defines an automatic refresh interval for the content in the Navigator.
By default, automatic refresh is turned off.

Table 12. Tasks tab
Setting

Description

Close dialog after
task completion

Automatically closes the dialog if the task was completed successfully.
If an error occurs, the dialog remains open.

Table 13. Open externally tab
Setting

55

Description

Properties

Customizes the settings for .csv files created by PLA 3.0.
• Line separator symbol: Sets the line separator used in the created
file.
• Export column header: Adds the PLA 3.0 column header as the first
row of the data set written to the .csv file.
• Column separator: Sets the column separator which is used to
separate the data columns in the created .csv file.
• Quote values: Activates a quote symbol that is used to quote data,
if necessary.
• Quote symbol: The symbol that is used when quoting data.

7.2 Changing your account settings
You can select a different avatar or add additional information about your user account.
To change your account settings:
1. Open the System menu, and select

My account.

2. In the My account dialog, change your account settings according to your requirements.
3. Click OK.

7.3 Changing your password
You can change your login password.
To change your password:
1. Open the System menu, and select

Change password.

2. In the Change your password dialog, enter your current and your new password.
3. Confirm the new password.
4. Click OK.
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8 Audit trail

Use the audit trail to access details on document-related actions. The audit trail on the
document level contains a subset of the entries available in the system-wide audit trail.
The audit trail logs all document-related actions, starting with document creation. Every action
creates an entry in the audit trail. The entry contains details about the type of action, the date
and time on which the action was performed, and the user who performed the action.
On the action bar, the Audit trail is located below the data editors. Select an entry to view its
details:

Figure 36: Details of an audit trail entry
Tip: Double-click an action in the upper table or an affected element in the lower table to
view extended audit trail details in a separate dialog.

8.1 Filtering audit trail entries
Apply filters to view only a subset of the available audit trail entries, for example, entries that
were created on a specific date or by a specific user.
To filter audit trail entries:
1. In the audit trail toolbar, click

Filter.

2. In the Document audit trail filter dialog, use the following criteria to define your filter:
◦ Operator: The user who performed the action.
◦ Action: The type of action that was performed, for example, the creation of a document
(OBJECT_INITIAL), or the application of an electronic signature (OBJECT_SIGN).
◦ Date: The date on which the action was performed. You can enter a specific date or a time
frame.
Note: The filter for objects is not available on the document level.

Example: The following filter displays only entries created by the operator 'Administrator' on
25-August, 2020:
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Figure 37: Audit trail filter on document level
3. Click Filter.
Results: The audit trail table is filtered according to your criteria.
4. To keep the filter active, click X to close the dialog. To reset the filter, click Reset before you
click X.
Tip: You can also reset the filter by clicking

Reset filter in the audit trail toolbar.

8.2 Exporting audit trail entries
Export audit trail entries to make them available in a log file, for example, if you want to print
them out.
Tip: Depending on the number of entries, the export can take several minutes. If you require
only a subset of the data, you can reduce the processing time by applying a filter before starting
the export.
To export audit trail entries:
1. In the audit trail toolbar, click

Export.

2. In the Export audit trail dialog, on the Settings tab, navigate to the directory where you
want to store the log file.
3. Click Start.
Results: The log file is created in the selected folder. You can open it in any text editor for
further processing.
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